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About This Guide

Document Overview

This guide provides detailed instructions on configuring the 6510 Unified 
Messaging (UM) system after you have installed the software. Detailed information 
is provided on modifying the PBX, creating a company, mailboxes, and feature 
groups. In addition, this guide also contains information on setting the different 
configuration parameters.

Note: Some screen captures in this document may not reflect the Mitel Networks™ 
6510 UM software exactly. All screens will be updated in the next release of 
the 6510 UM documentation.

Intended Audience

This guide is intended for anyone responsible for maintaining the 6510 UM.

Before You Begin

Before you configure the 6510 UM system, make sure that you have read 
the Server Installation Guide.

Conventions

This guide contains three types of help:

Note: contains additional information about the task you are 
performing

Hint: contains an alternative method of performing the task or 
offers a solution if you run into a problem.

Warning: contains critical information relating to the task.
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Contacting Mitel Networks

Contact us by mail at:

Mitel Networks Corporation

350 Legget Drive

Ottawa, ON K2K 2W7

Contact us by phone:

Tel: 613-592-2122

Fax: 613-592-4784

Contact us on the Web:

www.mitel.com
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CHAPTER 1 Using the UM Client Manager

In This Chapter . . .

Overview on page 12

Signing On on page 12

Configuring the Application on page 14

Using the UM Call Manager on page 24

Using Lan Talk on page 34

Creating a Buddies List on page 39

Using the UM Client Manager Toolbar (In Outlook) on page 48
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Using the UM Client Manager

Overview

The 6510 Unified Messaging system is an IP-based desktop application that allows 
you to access several unique communication features, such as Call control, instant 
messaging, and unified messaging.

You can log into the UM server from any PC connected to the Internet. After you 
enter the IP address of the UM server, you are logged in and can access all of the 
available communication functionality.

Signing On

Signing on allows you to begin the UM Client Manager program.

 To log onto the UM server: 

1. Click Start>Programs>UM Client Manager>UM Client Manager.

Hint:   You can also double-click on the UM Client Manager icon on 
the desktop.

The UM Client Manager will automatically load into your system tray after 
authentication, and will sit awaiting call activity. The status of your UM Client 
Manager session is represented by four icons:

Icons Session Status

Logged In

Logged In with New Message Awaiting

Logged Out

System detects Client Manager settings, but no 
connection is established
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Note:  When UM Client Manager is enabled, a notification window 
will pop up above the UM Client Manager icon whenever 
new messages are received. The notification window will 
display the number of new voice, text, and fax messages if 
the Show Message Count option is enabled (this is done in 
the Administration console. See Feature Groups>Mailbox 
Options in the Server Configuration Guide).

Signing Off

Signing off closes the UM Client Manager and ends your session.

 To sign off from LanTalk:

1. Right-click on the UM Client Manager icon and click Exit. The 
following message appears:

2. Click Yes.
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Configuring the Application

Before you can use UM Client Manager, you must configure the application. While 
this is normally done when the application is installed on your PC, you have the 
option of changing the settings.

There are four main settings to configure for the application.

• Main Settings

• Call Handling

• LanTalk (Instant messaging) Settings

• Notification Settings
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Configuring Main Settings

The Main tab allows you to change the personal settings required to log in 
successfully. 

Caution:   This information must be correct in order for UM Client Man-
ager and the forms to work properly.

 To configure main settings:

1. Click Start>Programs>UM Client Manager>Configuration. The 
Main dialog appears.

Note:  You can also access the Call Handling Dialog by right-clicking 
on the UM Client Manager icon, then selecting Options.

2. In the Company field, enter the company number or company 
name that your account is associated with on the UM.
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Note:  Ask your UM administrator for more information. 

3. In the Mailbox field, enter your Mailbox number for voice mail.

4. In the UMST Server IP Address field, enter the UMST Server IP 
address so the system can authenticate you using TCP/IP.

5. In the UMST Server Port field, enter the UMST server port number.

6. In the Web Server IP Address field, enter the web server IP address 
so that the system can authenticate you.

7. In the UM Client Language drop-down list, select the language 
that is to be used.

8. In the Fax Viewer field, click Browse to view the specific fax viewer 
application you already have loaded on the PC, or leave the field 
blank for the system to use the Windows default.

9. Click Change Password if you want to change the existing 
password. 

10.Click OK to finish the configuration, or click another tab to 
continue the configuration. 
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Changing your Password

Your password was set when UM Client Manager was installed on your PC. 
However, you can change the password if you feel that it is no longer secure.

 To change your password:

1. Click Change Password. The Change Password dialog appears.

2. In the Old Password field, enter the existing password.

3. In the New Password field, enter the new password.

4. In the Confirm Password field, enter the new password again and 
click OK. The new password takes effect the next time that you 
start UM Client Manager.
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Specifying Call Handling Settings

The Call Handling tab allows you to define the call handling settings, including PIM 
Integration, Default Action, New Call Popup, Public Contact Search, Auto Add 
Record and User Extension.

 To specify call handling:

1. Click the Call Handling tab. The Call Handling tab appears. 

2. Select New Call Popup to activate screen pops on incoming calls. 
When you receive a new call, the Call Manager screen will appear.

3. Select the Use Phone Formatting checkbox to enable phone 
formatting.

4. From the PIM Integration drop down list, select reverse lookups 
into PIM application on incoming calls for database pops.
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Note:  PIM stands for Personal Information Manager.

5. Select the Auto Add Record on Not Found checkbox to take the 
caller ID information of the caller’s name and number and create a 
new contact in Outlook if it is not found in the database. With 
Outlook, you can define the public folders as the database you 
want reverse lookups for, instead of your PST file.

6. Select the Search Public Contacts checkbox if you want the system 
to search the database for matching public contacts when an 
incoming call occurs.

Function Related Fields

Maximizer Select Auto Add record on Not Found to add the call 
record if it isn’t found in the database. This takes the 
caller ID information of name and number, and creates a 
new contact in Outlook or Act if they do not already have 
the record.

Goldmine No related fields.

ACT! Select Auto Add record on Not Found to add the call 
record if it isn’t found in the database. This takes the 
caller ID information of name and number, and creates a 
new contact in Outlook or Act if they do not already have 
the record.

Outlook Select Auto Add record on Not Found to add the call 
record if it isn’t found in the database. This takes the 
caller ID information of name and number, and creates a 
new contact in Outlook or Act if they do not already have 
the record.

Select Search Public Contacts to search the database for 
public contacts.

Select Eliminate New call Popup, if found to disable 
the new call popup if the number is found.

Custom ACTIVEX This allows a user with VB Script experience to integrate 
the screen pops and call controls into custom databases 
and applications.

In the ActiveX Class Name field, enter the class name of 
the Custom ActiveX you are using.
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7. Select Eliminate New Call Popup, If Found if you do not want a 
new call popup when a matching information is found for the 
incoming call by the system.

8. From the Default Action drop-down list, select a default action if 
you do not click on any actions on the incoming screen pop. 

These default actions will be overridden by the actions you may choose on an 
incoming screen pop.

9. In the Use Ext. field, enter the phone extension you are currently 
sitting at. This extension is used to transfer a call, play back a voice 
message, and dial a number.

10. In the Country drop-down list, select the country that is associated 
with the external extension.

11. In the City/Area Code field, enter the city area code for the 
external extension.

12. In the Number field, enter the extension number you are using.

Note:  If you do not enter a phone extension, the system will use 
your extension.

13. Click OK to end and finish the configuration, or click another tab 
to continue the configuration.

Action Function

Take Call Take the call automatically

Take Message Take a message automatically

Transfer Call By default, transfer the call to another extension
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Configuring LanTalk

LanTalk is the instant messaging module of the UM that allows you to chat with 
other users over an IP. 

 To configure LanTalk:

1. Click the LanTalk tab. The LanTalk dialog appears.

2. Click Background Color to set the background screen.

3. Click Foreground Color to set the color of the text. 

4. Click Font to configure font type and size.

Note:  For information on changing the color and font, refer to your 
Windows NT documentation.

5. Select the LanTalk Popup checkbox to turn instant messaging on.
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6. Select the New LanTalk Window for every Session checkbox to 
indicate that a new window should be used for every new LanTalk 
session.

7. Click OK to save the LanTalk settings.

Configuring Notifications

  To configure notifications:

1. Click the Notificaton tab. The Notification dialog appears.

• Select the When new messages arrive, make the icon flash check-
box to enable the 6510 UM Client Manager icon to flash when you 
receive a new message.
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• Select the When new messages arrive, popup notification win-
dow checkbox to enable the screen popup that notifies you of incom-
ing calls.

• Select the When others log in, popup notification window check-
box to enable the screen popup that notifies you of every user that 
logs in.

2. Customize the sounds you wish to use for each function by using 
the Browse button to select the appropriate sound files within the 
following fields:

3. Click OK to save your Notification settings.

Note:   The Notification sounds feature only supports sound files in 
.WAV format.

Option Function

New Message Select the sound file you want played when you 
receive a new message.

Urgent Message Select the sound file you want played when you 
receive an urgent message.

Record Beep Select the sound file you want played for the 
record beep.

New Call Select the sound file you want played when you 
receive a new call.

LanTalk Select the sound file you want played when you 
receive a LanTalk message.

Logged in User Select the sound file you want played when a 
user logs in.
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Using the UM Client Manager

Using the UM Call Manager

When a call comes through to your extension, the UM Client manager displays a 
screen pop that displays information about the phone call.

Note:  The Contacts feature and button will only appear if you set 
your PIM Integration Settings to use Outlook. 



6510 UM Client Application User Guide 25

Using the UM Client Manager

Using the Toolbar Buttons

There are nine buttons that allow you to perform various tasks within the eCall 
Manager display.

Button Function

Transfers the call to the active extension that your user account has 
been defined to. For more information, refer to “Using Web Client.”

Transfers the call to another extension. Click the arrow key to define the 
extensions.

Puts the incoming call on hold. Click the arrow key to select the length 
of time that the call will be on hold.

Sends the call to voice mail. Click the arrow to select what greeting to 
play the caller.

Allows you to pull a caller out of voice mail while they are leaving a 
message.

Allows you to dial back a number that left a message or called. You can 
go into contacts and used the dial button as well.

This button allows you to turn your do not disturb status on or off at 
any time.

This launches the embedded UM Client Manager Contact database to 
log call statistics and dial back. (Only functional in conjunction with 
Outlook).
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Using the UM Client Manager

Answering a Call

When a call appears on the UM Call Manager display, click Answer to transfer the 
call to your extension.

Note:  The Answer button is disabled until you receive another call.

Removing a Call

UM Client Manager gives you the option of removing one or all of the calls on the 
display.

 To remove a call:

1. Highlight the call to be removed and click Clear. A dialog appears, 
prompting you to confirm the deletion.

Note:  To remove all calls from the display, click Clear.

2. Click OK. UM Client Manager removes the calls from the screen.

Transferring a Call

When a call comes to your extension, you can transfer the call to another extension. 
After you specify the extension, it will be displayed in the Transfer drop down list 
and is available to use again.

Note:  The extension numbers that you enter are available until you 
exit UM Call Manager.
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 To transfer a call:

1. Click the arrow key to select the extension to transfer the call to. 
To specify an extension, click Other. The Transfer Call dialog 
appears.

2. Enter the mailbox number associated to the phone extension that 
you want to transfer the call to and click OK.

Note:  The Transfer button is disabled until you receive another call.
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Putting a Call on Hold

When a call comes through to your extension, you can put the call on hold until you 
have an opportunity to answer it.

 To put a call on hold:

1. Click the arrow key to select the length of time that you want to 
put the call on hold for. The Hold Call dialog appears.

2. Enter the number of minutes that you want the call held for, then 
click OK. After the time has expired, the system will play your voice 
mail greeting.

Note:  The Hold button is disabled until you receive another call. 

Taking a Message

When a call comes through to your extension, you can choose to send the call 
directly to your voice mail. When enabling this option from the UM Client Manager 
interface, you can select which pre-recorded greeting to use to greet the caller.
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 To take a message:

1. Click the Take Msg arrow key and select the greeting type you 
want the caller to receive. The UM Call Manager sends the caller to 
the selected greeting to record a message.

Pulling a Caller out of Voicemail

When a caller is in the process of leaving a message in your voice mailbox, you can 
choose to retrieve the caller from voicemail and speak to them directly. 

 To pull a caller out of voicemail:

1. While a caller is in a message recording session, click Recall. The 
caller is transferred to your extension.

Dialing a Number

The UM Client Manager allows you to use its interface to dial outgoing calls.

 To dial a number:

1. Click Dial. The following dialog appears:
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Using the UM Client Manager

2. From the Phone Number to Call drop down list, select a phone 
number to dial. You can also enter a number manually. 

3. From the Dialer Type drop down list, select a dialer type.

4. Select Long Distance if it is a long distance call. 

5. Click Go to dial.

Dialer Type Function

Server Dialer Sends data to the server and the server dials to the PBX

Local Dialer Sends data to the TAPI dialer and the TAPI dialer dials to the PBX.
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Specifying DND

DND (Do Not Disturb) allows you to activate a Do Not Disturb message when an 
incoming call appears in the popup.

 To specify do not disturb:

1. Click the Do Not Disturb icon. 

Adding a Call to the Contact Manager

Note:  This function is only available when PIM Integration is set to 
Outlook.

If your PIM Integration is set to Outlook, after you answer a call, you can add 
information about the caller to the Microsoft Outlook Contact Manager. For more 
information on how to use contacts, see your Outlook guide.
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Using the UM Client Manager

Changing your Present Status

UM Client Manger provides you with the ability to inform callers when you are not 
available to answer the phone. For example, if you are on holiday, you can instruct 
the system to inform a caller that you are away and the date when you will be back 
in the office. 

For information on how to record a greeting, refer to Maintaining Greetings on 
page 133.

 To change your status:

1. Right-click the UM Client Manager icon, then select Present Status.

2. Select the status that you want activated.

If you select a Present Status other than In Office or No Answer, the Available At 
dialog appears.

Status Function

In Office Rings your Active extension.

Busy Goes to voice mail and plays your busy greeting.

Meeting Goes to voice mail and plays your meeting greeting.

Do Not Disturb Goes to voice mail and plays your do not disturb greeting.

Lunch Time Goes to voice mail and plays that you are out to lunch.

Gone Home Goes to voice mail and plays the gone home greeting.

Out Of Town Goes to voice mail and tells the caller you are out of town.

Vacation Goes to voice mail and tells the caller you are on vacation.

No Answer Rings your active extension.
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3. Select the Available At checkbox to activate the schedule.

4. Click on a date when you will be back in the office.

5. Enter a time, then click Ok.

Note:  Once a Status is changed or defined, it will take time for the 
change to appear in Outlook. (Approximately one minute). If 
instantaneous change is needed, you must shutdown and 
restart Outlook, and the new Status will be activated.
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Using Lan Talk

Lan Talk is the instant messaging module that allows you to chat with other users 
over the IP. You can reach anyone who is logged into the same IP as the one that 
you are using, as well as send LAP and SMS messages.

Sending a Message

When logged in, you can send instant messages to others using LanTalk.

 To send a message (to a single user):

1. Right-click on the UM Client Manager icon and select Lan Talk. UM 
Client Manager enables you to Launch, Broadcast, or view the 
Directory. 

2. Click Launch. The Lan Talk dialog appears. 



6510 UM Client Application User Guide 35

Using the UM Client Manager

3. From the Select Destination drop-down list, select Select 
Destination from Lan Talk Directory. The Lan Talk Directory dialog 
appears, displaying a Buddies List compilation or a list of all users 
online, defining their name, mailbox number, and online status.
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4. Click the Company Directory tab, select a user, and click OK. The 
selected user appears in the Select Destination drop-down list.

Note:  The LanTalk Directory can also be accessed directly if you 
right-click on the UM Client Manager icon, select LanTalk and 
click Directory.

5. Select the Also Send to LAP checkbox to send to a pager (if 
applicable).

6. Select the Also Send to SMS checkbox to send to a mobile phone 
(if applicable).

7. In the empty field, enter the message that you want to send. 
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Note:  You can also select a previous message that you sent.

8. Click Send to send the message. The message is sent.
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Creating a Broadcast Message

Using the Broadcast Message feature is useful if you want to send the same 
message to everyone connected to the system.

 To create a broadcast message:

1. Right-click on the UM Client Manager icon and select Lan 
Talk>Broadcast.  The Lan Talk dialog appears.

2. In the Select Destination drop-down list, select Broadcast.

3. In the empty field, enter the message that you want to send.

Note:  You can also Send to LAP or Send by SMS, but as a Broadcast 
message, it is not recommended.

4. Click Send. The message is broadcasted.
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Creating a Buddies List

A Buddies List allows you to create a distribution list for Lan Talk broadcasts. After 
creating a Buddies List, you must add mailboxes (users) to the list. By creating and 
defining users on a Buddies List, you can send a broadcast message to the selected 
"buddies" with one click.

 To create a Buddies List:

1. Right-click on the UM Client Manager icon and select Lan 
Talk>Directory. The Lan Talk Directory (Buddies List tab) appears.

2. Click Tools>Add Buddies List. The Add Buddies List dialog appears.
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3. In the List Number field, enter the list number that will identify 
the Buddies List.

4. In the List Name field, enter a unique name for the Buddies List.

5. Click OK. The Buddies List appears in the Buddies List tab.
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 To rename a Buddies List:

1. In the Buddies List tab, select a Buddies List and click 
Tools>Rename Buddies List. The Delete Buddies List dialog 
appears.

2. Click Yes. The Rename Buddies List dialog appears.
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3. In the Enter new name field, enter the new name for the Buddies 
List.

4. Click OK. The Buddies List appears, labelled with its new name.

 To add mailboxes to the Buddies List:

1. In the Buddies List tab, select the Buddies List and click Tools>Add 
Mailbox. The Add Mailbox dialog appears.

You can either add mailboxes by searching for the mailbox number or by 
user name:

•  Select By Mailbox Number.

•  In the Mailbox Number field, enter the mailbox number to search 
for.
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•  Click Search. Any mailbox number that is found is displayed.

or

•  Select By Name. The Last Name and First Name fields appear.

•  In the Last Name field, enter the last name of the user you are search-
ing for.

•  In the First Name field, enter the first name of the user you are 
searching for.

•  Click Search. Any name that is found is displayed.

2. Select the user that you want to add and click Add to List. The user 
appears in the Buddies List.
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3. Repeat steps 1-2 to add all necessary users to your Buddies List.
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Deleting Buddies Lists and Mailboxes

You can delete individual mailboxes from Buddies Lists or delete entire Buddies 
Lists.

 To delete a mailbox from a Buddies List:

1. In the Buddies List tab, select a user and click Tools>Delete 
Mailbox. The Delete Mailbox dialog appears.

2. Click Yes. The mailbox is removed from the Buddies List.

 To delete a Buddies List:

1. In the Buddies List tab, select a Buddies List and click Tools>Delete 
Buddies List. The Delete Buddies List dialog appears.

2. Click Yes. The Buddies List is removed.
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Sending a Message Using a Buddies List

Once a Buddies List is created and multiple users are assigned to it, you can 
conveniently create Lan Talk messages that are sent to users specific to the Buddies 
List that is selected.

 Sending a message using a Buddies List:

1. Right-click on the UM Client Manager icon and select Lan 
Talk>Directory. The Lan Talk Directory (Buddies List tab) appears.
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2. Select the Buddies List to use and click OK. The Select Destination 
field displays the selected Buddies List.

3. In the empty field, enter the message that you want to send. 

4. Select the Also Send to LAP checkbox to send to a pager (if 
applicable).

5. Select the Also Send to SMS checkbox to send to a mobile phone 
(if applicable).

6. Click Send to send the message. The message is sent to all users 
that are defined in your Buddies List.
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Using the UM Client Manager Toolbar (In Outlook)

The UM Client Manager Toolbar is integrated into the Microsoft Outlook 
application, allowing you to send a voice, text, or fax message, as well as set your 
Present Status and launch LanTalk sessions. 

Note:  In cases where there are multiple Profiles being used on the 
same Outlook application, only the profile of the user who 
installs the software has access to the UM Client Manager 
Toolbar in Outlook.
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       Button Function

Compose a voice message (EE Voice Button)

Compose a text message (EE Text Button)

Send a fax message (EE Fax Button)

Set your Present Status

Launch a LanTalk conversation
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Message Tab

The Message tab allows you to compose voice, text and fax messages.

 To compose a voice message:

1. In Microsoft Outlook, click the EE Voice button. The EE Voice 
Message tab appears.

2. In the To field, enter the e-mail address that you are sending the 
message to.

3. In the Cc field, enter the e-mail address that you are carbon 
copying the message to. (If applicable).

4. In the Subject field, enter the subject for the message.

5. Under Choose Message Type, ensure that Voice is selected.

The sound recording toolbar is used to record and playback voice 
messages. There are buttons to record, clear, play, stop, rewind, and fast 
forward the message.
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 allows you to adjust the message volume and speed.

6. Click and begin recording the voice message with your 

microphone. Click  when finished recording.

7. Click  to verify that you message is recorded. If the message 

needs to be revised, click to clear the message and re-record 
your message.

8. In the text field at the bottom of the screen, enter any text that 
you want included with the message.

9. Click Send. The composed message is sent.
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 To compose a text message:

1. In Microsoft Outlook, click the EE Text button. The EE Text 
Message tab appears.

2. In the To field, enter the e-mail address that you are sending the 
message to.

3. In the Cc field, enter the e-mail address that you are carbon 
copying the message to. (If applicable).

4. In the Subject field, enter the subject for the message.

5. Under Choose Message Type, ensure that Text is selected.

6. In the text field at the bottom of the screen, enter your message.

7. Click Send. The composed message is sent.
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 To compose a fax message:

1. In Microsoft Outlook, click the EE Fax button. The EE Fax Message 
tab appears.

2. In the To field, enter the e-mail address that you are sending the 
message to.

3. In the Cc field, enter the e-mail address that you are carbon 
copying the message to. (If applicable).

4. In the Subject field, enter the subject for the message.

5. Under Choose Message Type, ensure that Fax is selected.

6. Click Add Attachments. The Open dialog appears. 
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7. Select the fax to attach to the message. The selected file appears 
in the field. 

8. In the text field at the bottom of the screen, enter any text that 
you want included with the message.

9. Click Send. The composed message is sent.
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Telephony Options Tab

The Telephony Options tab allows you to configure the voice format and device 
options. Correctly configuring these options will allow you to listen to voice 
messages that are received.

 To set telephony options:

1. In Microsoft Outlook, click the EE Voice button. The EE Voice 
Message tab appears.

2. Click the Telephony Options tab. The Telephony Options tab 
appears.

3. In the Voice Format drop-down list, select the voice file format to 
use for playback.

4. In the Sound Device drop-down list, select Sound Card to listen to 
voice messages through the sound card on your desktop and click 
Apply. Or, select Phone to listen to voice messages through your 
telephone. If Phone is selected, the Phone Extension field appears.
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5. Enter your phone extension and click Apply. Once this is selected, 
when a voice message is received and opened in Outlook, the 
system will call your telephone extension and the voice message 
will be played on your telephone.

6. Telephony Options are now configured.

Note:  Voice messages recorded through a microphone on a desktop 
cannot be played through the Phone sound device. It can only 
be played through the Sound Card sound device.
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Setting Present Status in Outlook

UM Client Manger provides you with the ability to inform callers when you are not 
available to answer the phone. For example, if you are on holiday, you can instruct 
the system to inform a caller that you are away and the date when you will be back 
in the office. 

 To set present status in Outlook:

1. In the UM Client Manager Status Toolbar (Outlook), click the 
Present Status drop-down list and select a status.

2. Your Present Status is set.

Status Function

In Office Rings your Active extension.

Busy Goes to voice mail and plays your busy greeting.

Meeting Goes to voice mail and plays your meeting greeting.

Do Not Disturb Goes to voice mail and plays your do not disturb greeting.

Lunch Time Goes to voice mail and plays that you are out to lunch.

Gone Home Goes to voice mail and plays the gone home greeting.

Out Of Town Goes to voice mail and tells the caller you are out of town.

Vacation Goes to voice mail and tells the caller you are on vacation.

No Answer Rings your active extension.
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Using LanTalk in Outlook

LanTalk is the instant messaging module that allows you to chat with other users 
over the IP. You can reach anyone who is logged into the same IP as the one that 
you are using. Integrated into Outlook, LanTalk is much more convenient for you to 
use to communicate with individuals logged into your network.

 To use LanTalk in Outlook:

1. In the UM Client Manager Status Toolbar (Outlook), click LanTalk 
and select Launch, Broadcast, or Directory.

•  To Launch a message, refer to To send a message (to a single user): on 
page 34

•  To Broadcast a message, refer to To create a broadcast message: on 
page 38

•  To use the Directory, refer to below.

2. Click Directory. The LanTalk Directory (Select Destination) dialog 
appears.

3. Highlight a user and click OK. The LanTalk/LAP dialog displays the 
user’s information.

4. From the Send Text drop- list, enter the message that you want to 
send. 

Note:  You can also select a previous message that you sent.

5. Click Send to send the message.

6. Click Clear to clear the current conversation off of your IM screen.
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In This Chapter . . . 

Overview on page 62

Ensuring SSL Requirement for Web Client on page 64

Starting Web Client on page 64

Using the Scroll Buttons on page 66

Using the Inbox on page 67

Playing a Voice Message on page 70

Viewing a Fax on page 72

Reading an E-mail on page 73

Composing a Message on page 74

Maintaining Folders on page 83

Maintaining the User Settings on page 89

Maintaining a Distribution List on page 118

Maintaining Notifications on page 120

Maintaining Greetings on page 133

Collaborate on page 138
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Overview

Web Client is a web-based interface that provides you with access to your 6510 UM 
account and features over the Internet. You can check your e-mails, phone 
messages, and faxes from anywhere in the world.

Enabling SSL for Web Client

Before using Web Client, it is recommended that you enable SSL on the Web Client 
website to ensure that the connection will be secure. Digital certificates encrypt 
data using Secure Sockets Layer (SSL) technology, the industry-standard method for 
protecting web communications. The SSL security protocol provides data 
encryption, server authentication, message integrity, and optional client 
authentication for a TCP/IP connection. SSL is built into all major browsers and web 
serversand by simply installing a digital certificate turns on their SSL capabilities. 

 To enable SSL for Web Client:

1. In ISS 5.0, right-click the Web Client website and select Properties.

2. In the Directory Security tab, click Edit Secure Communications.

3. Click Server Certificate. The Server Certificate wizard appears.

4. Click Next, select Create A New Certificate and then click Next.

5. Select Prepare the request no but send it later option and click 
Next.

6. Enter a name for the certificate and click Next.

7. Enter your Country, State/Province and City Locality and click Next.

8. Enter the file name for the request to be saved in and click Next. A 
summary of the information you have entered will be displayed.

9. Verify that the information displayed is correct and click Next.

After completing the Server Certificate wizard, a private and public key for the 
certificate request will be created. A certificate holds your name, your public key 
and any other information, all of which are signed by a Certification Authority (CA) 
using a private key and intergrity algorithm. The Private key will stay in your 
computer while the Public key will be sent to a CA.
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Note:  For this example, the CA Verisign is used and only the trial 
version method is illustrated. It is recommended that you 
apply for a commercial certificate once you have decided on 
the CA that best suits your needs.

10. In your web browser, go to www.verisign.com. 

11. In the Verisign website, click Get Trial SSL ID. You will be 
prompted to enter your information.

12. When prompted for CSR (Certificate Signing Request), open the 
request file that you saved in step 8 and copy and paste the 
contents of the request file in the space provided by Verisign. 
Verisign will e-mail the test Server-side certificate to the address 
you have specified.

Note:  Begin copying the request file from the line "Begin New 
Certificate Request".

13. To ensure that the certificate you receive is Base64 encoded, 
create an empty file with the extensions ".cer" and copy and paste 
the contents that appear between the lines "Begin Certificate" and 
"End Certificate".

14. In IIS 5.0, click the Properties/Directory Security tab.

15. Click Edit Secure Communications and then click Server Certificate.

16. Select Process the pending request and install the certificate and 
click Next. 

17. Select the filename for you created from the certificate that 
Verisign issued to you (in .cer format) and click Next.

18. Verify that the certificate overview information is correct and click 
Next.

19. Click Finish. Your web server certificate is installed for Web Client.
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Ensuring SSL Requirement for Web Client

Sometimes your URLs will be changed back to HTTP and you will be making regular, 
non-secure HTTP connections. To ensure that your server will require an SSL 
connection for your web service at all times, you need to specify that SSL is required 
on the virtual directory your service is located in.

 To ensure SSL requirement:

1. In the IIS 5.0 Manager, right-click the UM/Web Client virtual 
directory and click Properties.

2. In the Directory Security tab, click Edit Secure Communications.

3. Select Require SSL.

 Starting Web Client

In order to access your 6510 UM account over the Internet, you must first start the 
Web Client.

 To start Web Client:

1. Open your browser (using Microsoft Explorer 6.0 or greater or 
Netscape Navigator 6.2 or greater). The Web Client screen 
appears.

2. In the Address field, enter the IP address of the UM server and click 
Go.

 Note: If you do not know the proper IP address, contact your 
Network Administrator. 

3. Click Web Client. The Web Client dialog appears. 

4. Select a language interface from the selection on the left hand 
side.

Note:  The default is English.

5. In the Mailbox field, enter your mailbox number.

6. From the Company drop down list, select a company (if there are 
multiple companies in the UM system).
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7. In the Password field, enter your password and click Login. The 
Top\Inbox\ screen appears. 

Logging Off

After finishing the Web Client session, you must log off.

 To log off:

1. Click Log Off. A message appears prompting you to confirm log 
off action.

2. Click OK. The Web Client screen appears.
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Using the Scroll Buttons

Scroll buttons allow you to scroll through the display of messages. 

Note:  Scroll buttons appear in both the Inbox and Folders 
applications. 

Using the Main Toolbar Functions

The left hand side of the screen displays the main toolbar functions.

Button Name Function

First Record Scrolls to the first record

Previous Record Scrolls to the previous record

Next Record Scrolls to the next record

Last Record Scrolls to the last record

Toolbar Function Name Purpose

Inbox Displays all of your messages

Folders Displays your folders

User Settings Configure your user properties

Distribution List Create and edit your distribution lists

Notification Sets up and configures notification 
properties on new messages
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Using the Inbox

The Inbox displays all of the voicemails, faxes, and e-mails that have been sent to 
your mailbox. 

Wakeup Call Setup and configure a wakeup call

Greetings Record and edit greetings

Log Off Log off of Web Client
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Message Icons

There are seven message icons used to represent information about each message 
in the Inbox.

Icon Name Function

Voice Indicates a voice message that you 
have not listened to

Voice Indicates a voice message that you 
have listened to

E-mail Indicates an e-mail that you have not 
read

E-mail Indicates an e-mail that you have read

Fax Indicates a fax message

Importance Indicates the importance of the 
message

Private / Certified Indicates that the message cannot be 
forwarded to another user. The icon 
also indicates that you will receive a 
message in your Inbox when the 
recipient has listened to your voice 
message.
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Displaying Messages by Type

You can display the messages in any folder either by type or all messages together. 
The default is Show All.

Using the Toolbar Buttons

There are nine buttons that allow you to perform various tasks within the Inbox.

Button Name Function
Compose new message Compose a new voice message,       e-mail, or 

fax
Reply Reply to the message

Forward Forward the message to another user.

Refresh Refresh the display

Copy marked items Copy a marked item

Move marked items Move a marked item

Delete marked items Delete a marked item
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Playing a Voice Message 

Using Web Client, you can play back any voice mail message that has been sent to 
your mailbox. If there are any attachments to the voice message, Web Client will 
download the files to your PC. 

Add Add a recipient

Remove Remove a recipient
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 To play a voice message:

1. In your Inbox, click the icon beside the voice message that you 
want to hear. The Voice Message From dialog appears.

The Windows Sound Player becomes active and plays the message automatically.

2. From the List of Attachments drop down list, select an attachment, 
then click Open. The Save As dialog appears.

3. Select a directory to save the file to, then click Save. When the 
download is complete, click Close.

4. To return to the Inbox, close the window.
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Correcting a Voice Message Play Error

Due to a known sound card driver problem specific to certain sound cards,  the 
applet may crash if the Playback Speed bar is dragged when playing a message in 
Web Client. If this error occurs, the error can be corrected.

 To correct a voice message play error:

1. In your Windows Desktop, click Start>Settings>Control Panel. The 
Control Panel window appears.

2. Double-click the Sounds and Multimedia icon. The Sounds and 
Multimedia Properties dialog appears.

3. Click the Audio tab and under the Sound Playback box, click the 
Advanced button. The Advanced Audio Properties dialog appears.

4. Click the Performance tab. The Performance tab appears.

5. In the Hardware Acceleration section, drag the bar to None and 
click OK. The Sounds and Multimedia Properties dialog appears.

6. Under the Sound Recording box, click the Advanced button. The 
Advanced Audio Properties dialog appears.

7. Repeat step 5 above and click OK.

8. Close all browser windows and restart Web Client.

Viewing a Fax

If you have Fax Client installed on your PC, you can view any fax that has been sent 
to your mailbox. 

 To view a fax:

1. In your Inbox, click the Fax icon. The fax message appears.

2. Select the fax from the List of Attachments drop-down list if the 
fax is an attachment in the message. The fax message appears.
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Reading an E-mail

Web Client gives you the ability to read your e-mails either in the office or from any 
where in the world.

 To read an e-mail:

1. In your Inbox, click the E-mail icon. The following dialog appears.

2. From the List of Attachments drop down list, select an attachment, 
and click Open. The Save As dialog appears.

3. Select a directory to save the file to, then click Save. When the 
download is complete, click Close.

4. To return to the Inbox, close the window.
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Refreshing the Display

Web Client refreshes the display automatically so that the most recent messages 
always appear in your Inbox. However, you can also refresh the display manually by 
clicking Refresh.

Composing a Message

Web Client gives you the ability to compose one of three types of messages: Voice, 
Text, or Fax. The message can then be sent to the following types of users:

• UM

• VPIM

• AMIS

• E-mail

In addition, you can also send the mail to a Distribution list

Creating a Voice Message

If you have a microphone attached to your PC, you can use Web Client to send a 
voice message.

 To create a voice message:

1. In your Inbox, click Compose new message. The Compose New 
Message dialog appears.
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2. Select Voice and click OK. The From dialog appears.

3. From the Importance drop down list, select Normal or High 
(Urgent) to specify the importance of the voice message. 

4. Select Certified if you want to receive a message that the recipient 
has listened to your voice message. 

5. Select Private (Not Forwardable) to prevent the receiver from 
forwarding the voice mail message to another user.

6. Click Attachments if you want to attach a file to the voice 
message. 

7. Click To to specify the recipients. The To dialog appears. 

Note:  You can also enter the recipient’s extension.
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8. Highlight a recipient, then click the Add arrow. When you have 
finished adding all of the recipients, click OK. The From dialog 
appears.

9. In the Subject field, enter the subject of the voice message.

10. Click Record to record the voice message. Click Stop when you 
have finished recording. Click Play to review the voice message.

11. Click Send.

Web Client keeps a copy of your voice message in the Sent folder.
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Creating a Text Message

You can use Web Client to create a text message.

Note: There is no limit to the length of the text message. 

 To create a text message:

1. In your Inbox, click Compose New Message. The Compose New 
Message dialog appears.

2. Select Text, then click OK. The From dialog appears.

3. From the Importance drop down list, select Normal or High 
(Urgent) to specify the importance of the text message. 

4. Select Certified if you want to receive a message in your Inbox that 
the recipient has read your text message. 

5. Select Private (Not Forwardable) to prevent the receiver from 
forwarding the text mail message to another user.
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6. Click Attachments if you want to attach a file to the text message. 

7. Click To to specify the recipients. The To dialog appears. 

8. Highlight a recipient and click the Add arrow. When you have 
finished adding all of the recipients, click OK.

9. Enter the text message and click Send.

Web Client keeps a copy of your voice message in the Sent folder.

Creating a Fax Message

You can create fax messages to send to your contacts.

 To create a fax message:

1. Click Compose New Message. The Compose New Message dialog 
appears.

2. Select Fax and click OK. The Fax dialog appears.

3. From the Importance drop down list, select Normal or High 
(Urgent) to indicate the importance of the message. 

4. Select Certified if you want to receive a message in your Inbox that 
the recipient has read your message.

5. Select Private (Not Forwardable) to prevent the receiver from 
forwarding the message to another user.

6. Click Attachments if you want to attach a file to the message.

7. Click To to attach recipients to the fax. The To dialog appears.
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8. Highlight a recipient and click the Add arrow. When you have 
finished adding all of the recipients, click OK. The From dialog 
appears.

9. In the Subject field, enter the subject of the fax.

10.In the Fax File field, enter the file you want to send and click Send.

11.Web Client keeps a copy of your voice message in the Sent folder.

Adding an Attachment to a Message

Web Client allows you to add one or more attachments to your voice, text, or fax 
message.

 To add an attachment:

1. While composing any type of message in the From dialog, click 

Attachments . The Attachments dialog appears.

2. In the Attach File field, enter the directory and name of the file 
and click Add. 

Note:  Click Browse to navigate to a directory.

3. Highlight the file, then click Remove to remove the file.
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4. Click Clear All to remove all of the attached files.

5. Repeat step 2 to add another file, or click OK to return to the From 
dialog.

Replying to a Message

After you have read a message, you can reply to the sender with a comment using 
Voice, Text, or Fax. You can also forward a copy of the message to another user and 
include your comments.

 To reply to a message:

1. To reply to a message from the Inbox, select the check box beside 
it and click Reply.

Note:  You can only reply to one message at a time.

2. If you are reading the e-mail, listening to a voice message, or 
viewing a fax, click Reply. The Reply dialog appears.

3. Select the method that you want to use to reply to the message 
and click OK. Depending on the reply method you selected, the 
appropriate dialog appears.

4. Complete the dialog and click Send. Web Client puts a copy of the 
message to each user in your Sent folder.

Forwarding a Message
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You can forward a message either from the Inbox or while you are reading it.

 To forward a message:

1. Select the check box beside the message that you want to 
forward, then click Forward.

Note:  You can only forward one message at a time.

2. If you are reading the e-mail, listening to a voice message, or 
viewing a fax, click Forward. The Forward dialog appears.

3. Select Add Comment if you want to add a comment and click OK. 
The Voice, Text, and Fax options become active.

4. Select the method that you want to use to reply to the message 
and click OK. Depending on the reply method you selected, the 
appropriate dialog appears.

5. Complete the dialog and click Forward. Web Client puts a copy of 
the forwarded message to each user in your Sent folder.

Copying a Message

Web Client allows you to copy one or more messages and store them in another 
folder. This is useful if you would like to have copies of your messages stored in 
more than one folder.

You can copy messages either from the Inbox (if you want to copy more than one), 
or after you have read it.

 To copy one or more messages:

1. Select the folder containing the messages that you want to copy.

2. Beside each message, select its check box, then click Copy marked 
items. If you are reading the message, click Copy to another 
folder. The Copy marked items dialog appears.
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3. Select the folder to copy the messages to, then click OK. The folder 
that you copied the messages to appears on the desktop. The 
folder that you copied the messages from still contains the original 
messages that you copied.

Moving a Message

Web Client allows you to move one or more messages from one folder to another. 
This is useful if you want to sort your messages by sender or subject.

 To move one or more messages:

1. Select the folder containing the messages that you want to move.

2. Beside each message, select its check box, then click Move marked 
items. If you are reading the message, click Move to another 
folder. The Copy marked items dialog appears.
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3. Select the folder to move the messages to, then click OK. The 
folder that you moved the messages to appears on the desktop

Deleting a Message

Once you have read a message, you can delete it from its folder.

 To delete one or more message:

1. Select the folder containing the messages that you want to delete.

2. Beside each message, select its check box, then click Delete marked 
items. If you are reading the message, click Delete.

Web Client removes the messages from the folder and puts them into the Deleted 
Items folder. 

Maintaining Folders

You can create an unlimited number of folders to help organize your voice 
messages, e-mails, and faxes.
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Using the Toolbar Buttons

There are six buttons that allow you to perform various tasks within the Folders 
application.

Creating a New Folder

You can create a new folder to be at the same level as the default folders or to be a 
sub-folder. 

Note:  If you want the new folder to be a sub-folder, select the 
parent folder first.

 To create a new folder:

1. Click Create a new folder. The New Folder dialog appears. 

Button Name Function

Create a new folder Creates a new folder

Delete the current folder Deletes the current folder

Rename the current folder Renames the current folder

Copy the current folder Copies the current folder

Move the current folder Moves the current folder

Empty Deleted Folder Removes the contents of the Deleted 
folder
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2. Enter the name of the new folder, then click OK. Web Client 
displays the folders in alphabetical order.

Deleting a Folder

You can delete any folder that you have created, with the exception of the five 
default folders.

Caution:   Deleting a folder deletes the contents of that folder, including 
all sub-folders.

 To delete a folder:

1. Click on the folder that you want to delete.

2. Click Delete the current folder. A message appears, prompting you 
to confirm deletion.

3. Click OK. Web Client removes the directory from the display.

Renaming a Folder

You can rename any of existing folders.

Note:  You cannot rename any of the default folders.

 To rename a folder:

1. Click on the folder that you want to rename.

2. Click Rename the current folder. The Rename Folder dialog 
appears.
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3. Enter the new name of the folder, then click OK. Web Client 
displays the new name of the folder.

Copying a Folder

You can copy an existing folder to another folder. For example, you could have two 
folders both named “Budgets.” One budget folder could be in the “This Year” 
folder, while the other budget folder could be in the “Next Year” folder.

Note:  You cannot copy any of the folders that come installed with 
Web Client.

 To copy a folder:

1. Click Folders, then select a folder.

2. Click the Copy the current folder icon. The Copy the Current Folder 
dialog appears.
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3. Select a folder to copy the folder to, then click OK. The folder is 
copied to the indicated folder.

Moving a Folder

You can move folders to other folders and directories.

Note:  You cannot move the five default folders.

 To move a folder:

1. Select a folder.

2. Click Move the current folder. The Move the current folder dialog 
appears.
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3. Select where you want to move the folder and click OK. Web 
Client displays the folder directory tree with the selected folder 
moved into the new position. 

Recovering Deleted Messages

Each time you delete a voice message, e-mail, or fax message, Web Client stores the 
message in the Deleted Items folder. This allows you to recover deleted messages if 
you change your mind about deleting one or more messages, you can move them 
from the Deleted Items folder to another folder.

 To recover a deleted message:

1. Click Folders, then Deleted Items. The Deleted Items dialog 
appears.

2. Select the check box beside each message that you want to keep, 
then click Move marked items. The Move marked items dialog 
appears.

3. Select the folder to store the recovered messages and click OK. 
Web Client moves the deleted messages into the selected folder.
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Emptying the Deleted Items Folder

Emptying the Deleted Items folder removes all of the deleted messages and folders 
from Web Client permanently. 

Caution:   Once you empty the Deleted Items folder, you cannot recover 
the deleted messages.

 To empty the Deleted Items folder:

1. Click Inbox or Folders.

2. Click Empty Deleted Folder. A message appears, prompting you to 
confirm deletion.

3. Click OK. The system deletes all items stored in the Deleted Items 
folder.

Maintaining the User Settings

The User Settings function allows you to maintain your mailbox on Web Client. You 
can specify a number of settings including:

•  General Options

•  Message Options

•  Call Options

•  Addresses
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Using the Toolbar Buttons

There are 12 buttons that allow you to perform various tasks within the User 
Settings application.

Button Name Function

Save Saves the mailbox

Refresh Refreshes the display

Schedule (Status) Create a status schedule

Schedule (Phone Addresses) Create a Phone Addresses 
Schedule

Schedule (E-mail Address) Create a E-mail address schedule

Schedule (Fax Number) Create a Fax Number schedule

Add Add a phone address

Remove Remove a phone address

Edit Edit a phone address

Delete all Delete all mailboxes

Add Item Adds item

Delete item Deletes item
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Specifying General Options

The General options screen allows you to specify:

• your presence status

• your passwords

• collaboration services

Specifying your Presence Status

Web Client provides you with the ability to inform callers when you are not 
available to come to the phone. For example, if you are on holidays, you can 
instruct the system to inform a caller that you are away and the date when you will 
be back in the office.

Note:   The Web Client setting overrides the setting that you 
specifed in UM Client Manager.

 To specify your presence status:

1. Click User Settings. The User Settings screen appears.

2. Click Status. The Status screen appears.

3. From the Status drop-down list, select your current status. An 
appropriate greeting will play for each status.
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4. Select Available at if you want to specify a time when you will be 
available. In the year, month, day, hour, and min fields, enter the 
date and time when the selected status takes affect.

5. Click Save.

Creating a Status Schedule

Web Client provides you with the capability to create a schedule specifying when a 
particular status greeting is played. For example, you can specify that the “In 
Office” greeting plays Monday to Friday, between 9 am and 5 pm. 

 To create a status schedule:

1. Click Schedule. The Status Schedule dialog appears.

Note:  Web Client automatically activates the schedule.

2. From the Default drop down list, select the default status greeting 
that will run if the schedule expires. 
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3. From the From - year, month, and day drop down list, select the 
year, month, and day when you want the voice menu to start 
playing.

4. From the To - year, month, and day drop down list, select the year, 
month, and day when you want the voice menu to end playing.

Note:  Select All Day if you want the voice menu to play all day.

5. Enter the From and To hours, in military format. For example, if 
your company wants the voice menu to play from 9:00 AM to 5:00 
PM, set the hours as From 09:00 and To 17:00. If no time is entered, 
the system will assume all hours.

Note:  A value of From 13:00 to blank indicates 1:00 PM to midnight.

          The maximum value is 23:59 and the minimum value is 0:00.

          Other than a Blank value, the From field cannot be greater 
than the To field.

6. Select the days of the week on which the greeting is to play.

Note:   If you want the message to run every day, select Every day.

7. From the Status drop down list, select the greeting that will run.

8. Click OK.

Editing a Status Schedule

The status schedule that you create can be edited at any time.

 To edit a status schedule:

1. Click Schedule. The Status Schedule dialog appears.

2. Click the scroll bars to display the status schedule that you want to 
edit.

3. Make the necessary changes, then click OK.

4. Repeat steps 2 and 3 to edit another status schedule, or click OK to 
return to the General dialog.
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Deleting a Status Schedule

The status schedule that you create can be deleted any time.

 To delete a status schedule:

1. Click Schedule. The Status Schedule dialog appears.

2. Click the scroll bars to display the status schedule that you want to 
delete and click Delete Item. A message appears, prompting you 
to confirm deletion.

Note:  Click Delete All to delete all of the Status Schedules.

3. Click OK.

4. Repeat steps 2 and 3 to delete another status schedule, or click OK 
to return to the General dialog.

Specifying a Password

When you login to Web Client, the system prompts you for a password. This 

 To specify a password:

1. Click User Settings. The User Settings screen appears.

2. Click Passwords. The Password screen appears.

3. In the Password field, enter a password.
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4. In the Confirm Password field, enter the password again, then click 
Save.

Specifying a POP3 / IMAP4 Password

POP3 is a protocol used by Web Client to retrieve your messages from the server. If 
your system is not using POP3, it will use IMAP4. If your system is using either POP3 
or IMAP4, you must specify a password for authentication. 

 To specify a password:

1. In the Passwords screen:

2. In the User Name field, enter the user name.

3. In the Password field, enter the password.

4. In the Confirm Password field, enter the password again.

5. Click Save.

Specifying Collaboration

The Collaboration feature allows you to link to your desired Collaboration or 
Meeting services. You can either specify a Company defined service, or a User 
defined service. By default, the system is set to a Company defined service and the 
WebEx website. You can choose to identity an alternate service by selecting the 
User defined feature, and entering the corresponding personal collaboration url.

 To specify the collaboration service:

1. Click User Settings. The User Settings (General) screen appears.

2. Click Collaboration. The Collaboration screen appears.

Note: By default, the system is already set to use the Company 
defined service (WebEx).
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3. In the Active Collaboration Service drop-down list, select User 
Defined Services. The User Defined Services field appears.

4. In the User Defined Services field, enter the url for the service that 
you want to use.

5. Click  Save.
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Specifying Message Options

Message Options allow you to specify message sorting and order, message 
forwarding, and playback/record devices.

Sort/Order Messages

The Sort/Order messages feature allows you to specify the in order in which 
messages should be played.

 To sort/order messages:

1. Click User Settings. The User Settings (General) screen appears.

2. Click Sort/Order. The Sort/Order screen appears.

3. Select LIFO or FIFO.

4. Click Save.

Message Playback Definition

FIFO (First In, First Out) FIFO plays the oldest message first and the newest 
message last.

LIFO  (Last In, First Out) LIFO plays the newest message first.
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Specifying Message Forwarding

Web Client allows you to forward your messages to another mailbox, distribution 
list, AMIS or VPIM account, or an e-mail account. This is useful if you want to 
designate where certain messages should be forwarded.

 To specify message forwarding:

1. Click User Settings. The User Settings (General) screen appears.

2. Click Message Forwarding. The Message Forwarding screen 
appears.

3. From the Address Type drop down list, select an address type. 
Depending on the address type you select, you must follow the 
corresponding steps listed in the following:

 For Mailbox and Distribution List:

1. In the Address drop-down list, select the mailbox or distribution 
list to use.

2. In the After Hour(s)/Minute(s) fields, enter when message 
forwarding should be enabled.

3. Select the Delete After Forward checkbox to delete each message 
after forwarding.
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For AMIS or VPIM:

1. In the Remote Sites drop-down list, select the remote site.

2. In the Address field, enter the remote mailbox to use.

3. In the After Hour(s)/Minute(s) fields, enter when message 
forwarding should be enabled.

4. Select the Delete After Forward checkbox to delete each message 
after forwarding.

For E-mail:

1. In the Address field, enter the e-mail address to use.

2. In the After Hour(s)/Minute(s) fields, enter when message 
forwarding should be enabled.

3. Select the Delete After Forward checkbox to delete each message 
after forwarding.

4. Click Save.

Specifying Playback/Record Options

The Playback/Record Options feature allows you to specify message playback 
options as well as indicate the playback and record devices.

 To specify message playback/record options:

1. Click User Settings. The User Settings (General) screen appears.

2. Click Playback/Record. The Telephony/Web Client options screen 
appears.
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3. Select Say Date and Time if you want to hear the date and time 
stamp before every message. 

4. In the Playback Device drop-down list, select the device to use for 
message playback.

5. In the Record Device drop-down list, select the device to use for 
recording greetings and messages.

Note: If Phone is selected in either drop-down list, extra fields 
become available.
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6. In the Address Type drop-down list, select the address type.

7. In the Country drop-down list, select the country that the phone is 
located in.

8. In the Area/City Code field, enter the area/city code for the phone 
number.

9. In the Number field, enter the phone number.

10. Click Save.
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Defining Call Options

Call Options allows you the flexibility to assign transfer options and enable/disable 
call forwarding.

Specifying Transfer Options

By specifying the transfer options, the system will use the assigned active greeting 
and call functions to receive callers. 

 To transfer options:

1. Click User Settings. The User Settings (General) screen appears.

2. Click Transfer Options. The Transfer Options screen appears.

3. From the Active Greeting drop down list, select the active greeting 
that you want the system to play when a caller dials your 
extension.

4. From the Caller ID drop down list, select the method that Web 
Client will use to notify you of a call.

Caller ID Function

None Turns off screen pops on Call Manager.
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5. From the Personal Operator drop-down list, select the personal 
operator extension that you want the call to be transferred to.

6. Select Call Screening if you want the system to instruct callers who 
want to be transferred to an extension to state their name at the 
tone.

Before the call is transferred, you will hear the caller's name followed by the system 
prompt: "To accept the call press <1>, to reject the call press <#>, or to redirect the 
call press <2>.” If you reject the call, the caller hears a no-answer message and is 
given the choice of trying another extension, leaving a voice mail message, or 
dialing the operator's extension. To redirect the call, press <2> and the destination 
extension number, then hang up to transfer the call.

7. Select Call Queuing if you want incoming calls to be placed in a 
queue when an extension is busy. Callers are informed of their 
position in the hold queue and given opportunities to either 
continue to hold or leave a voice message. 

Caution:   Call Screening and Call Queuing are only available on telephone 
systems that provide a busy tone. Most telephone sets with 
multiple extension appearances do not produce a busy tone.

Note:  Call Screening and Call Queuing are mutually exclusive. You 
must choose one or the other, but not both.

8. Select Pre Transfer Paging if you want to be paged before the call 
is transferred. When a caller requests an extension, the caller is put 
on hold and the Telephony Enterprise system pages you. The 
system then waits for a definable period of time (timer is defined 
in the PBX Advanced dialog with a default of 5 seconds), and 
transfers the caller to the desired extension.

9. Select Post Transfer Paging if you want to be paged after the call is 
transferred. When a caller transfers to an extension that is busy or 
is not answered the caller is forwarded to your mailbox. In your 
personal greeting, you can offer callers the predefined option to 

Ask Prompts a caller to input their phone number before Web Client 
transfers the call. The phone number is used in screen pops if you are 
using Call Manager.

Pop Provides a screen pop even if there is no caller ID information available.

Ask and Pop Prompts the caller to manually input their number so it can be used in 
the screen pop if no caller ID is available or it is not passed by the telco. 
This guarantees that a number appears for all incoming calls to you.
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page you over the telephone intercom system (for example, "Press 
4 to have me paged"). Callers must be informed of the paging 
feature in the user's personal greeting. The system does not have a 
pre-recorded prompt.

All messages are tagged with a Date and Time stamp. Select Say Date and Time if 
you want to hear the date and time stamp before every message.

Note:   If you do not select this feature, the date and time stamp will 
not play.

10.Click Save.

Enabling the Call Forwarding Feature

When call forwarding is enabled, all calls will be forwarded to the assigned number.

 To enable call forwarding:

1. Click User Settings. The User Settings (General) screen appears.

2. Click Call Forwarding. The Call Forwarding screen appears.

3. Select the Call Forwarding Enable checkbox if you want your calls 
to be forwarded to another extension.

4. From the Call Forward to drop-down list, select the extension 
where your calls will be forwarded to.
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5. Click Save.

Adding a Phone Address

You can add a phone address at any time.

 To add a phone address:

1. Click User Settings. The User Settings (General) screen appears.

2. Click Phone. The Phone screen appears.

3. Click Add. The Add Address dialog appears.
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4. From the Address Type drop down list, select an address type.

5. If you select External or Centrex, the Country and Area/City Code 
fields become active.

6. From the Country drop down list, select a country.

7. In the Area/City Code field, enter the area or city code.

8. In the Number field, change the extension.

9. Select Set as Default to specify the extension as the default, then 
click OK.
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Editing a Phone Address

You can edit an existing phone address at any time.

Note:  You cannot edit your extension from the General screen. 

 To edit the address type:

1. Highlight a phone address and click Edit. The Web Page dialog 
appears.

2. Make the necessary changes, then click OK.

Deleting a Phone Address

You can delete an existing phone address at any time.

 To delete an address type:

1. Highlight the phone address that you want to delete and click 
Remove. A message appears, prompting you to confirm deletion.

2. Click OK.

Creating a Phone Addresses Schedule

You can create a Phone Addresses Schedule to specify which phone extension the 
system should use at certain times. This is useful if you work from different 
extensions at different times or days. 

 To create a phone address schedule:

1. Click User Settings. The User Settings (General) screen appears.

2. Click Phone. The Phone screen appears.

3. Click Schedule. The Phone Addresses Schedule dialog appears.
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Note:  Web Client automatically activates the schedule.

4. From the Default drop down list, select the default extension that 
will be used if the schedule expires.

5. From the From - year, month, and day drop down list, select the 
year, month, and day when you want the phone extension to start 
being used.

6. From the To - year, month, and day drop down list, select the year, 
month, and day when you want to stop using the phone 
extension.

Note:  Select All Day if you want the voice menu to play all day.

7. Enter the From and To hours, in military format. For example, if 
your company wants the voice menu to play from 9:00 AM to 5:00 
PM, set the hours as From 09:00 and To 17:00. If no time is entered, 
the system will assume all hours.

Note:  A value of From 13:00 to blank indicates 1:00 PM to midnight.

          The maximum value is 23:59 and the minimum value is 0:00.
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          Other than a Blank value, the From field cannot be greater 
than the To field.

8. Select the days of the week on which you want the extension to 
be called.

Note:   If you want this extension to be reached every day, select 
Every day.

9. From the Phone Addresses drop down list, select the phone 
addresses that will run.

10. Click OK.
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Specifying E-mail Addresses

Specifying e-mail settings allows you a number of e-mail addresses where you can 
be reached when an unread message is received.

 To specify e-mail addresses and settings:

1. Click User Settings. The User Settings (General) screen appears.

2. Click E-mail. The E-mail screen appears.

3. Select the Send E-mail with New Messages checkbox if you want to 
send defined e-mails with the message.

Note:  The Attach Voice File to E-mail selection becomes active if 
you select Send E-mail with New Messages.

4. Select the Attach Voice File to E-mail checkbox if you want to 
attach a voice message to an e-mail.

5. Select the Send E-mail with New Text Messages checkbox if you 
want to send defined e-mails with the message.

6. Select the Attach Text File to E-mail checkbox if you want to 
attach a text file to the message.
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7. Click Add to add an e-mail address. The e-mail address dialog 
appears.

8. In the E-mail Address field, enter the e-mail address.

9. Select Set as Default if you want to make this e-mail address the 
default address, then click OK.

10. Click Save.

Editing an E-mail Address

After specifying e-mail addresses, you can edit them at any time.

 To edit an e-mail setting:

1. Highlight the e-mail address you want to edit and click Edit. The e-
mail address dialog appears.

2. Make the appropriate changes to the settings and click OK.

3. Click Save.

Removing an E-mail Address

You can delete e-mail addresses at any time.

 To remove an e-mail setting:

1. Highlight the e-mail address you want to delete and click Remove. 
The delete address dialog appears.

2. Click OK to confirm the deletion.
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Configuring an E-mail Settings Schedule

An e-mail address schedule allows you to define when the system should send 
unread messages to certain individual e-mail addresses.  

 To configure an e-mail settings schedule:

1. Click User Settings. The User Settings (General) screen appears.

2. Click E-mail. The E-mail screen appears.

3. Click Schedule. The e-mail schedule dialog appears.

4. Select the Schedule Enabled checkbox to enable the schedule.

5. In the From Year/Month/Day drop-down lists, select the year, 
month and day you want the schedule to begin.

6. In the To Year/Month/Day drop-down lists, select the year, month 
and day you want the schedule to end.

7. Click the checkbox that represents the day or days you want the 
schedule to be enabled or select the Every day checkbox to enable 
the schedule everyday.

8. In the E-mail drop-down list, select the e-mail address that is to be 
associated with the schedule.

9. Click OK.
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Specifying Fax Addresses

You can specify and add Fax addresses.

 To specify fax addresses:

1. Click User Settings. The User Settings (General) screen appears.

2. Click Fax. The Fax screen appears.

3. Select the Send E-mail with New Faxes checkbox if you want to 
send defined e-mails with the message.

4. Select the Attach Fax File to E-mail checkbox if you want to attach 
a fax message to an e-mail.

5. Select the Optical Character Recognition checkbox.

6. In the Fax Number box, click Add to add a fax number. The Fax 
Number dialog appears.

7. In the Internal/External drop-down list, select whether the fax 
number is internal or external.

8. In the Country drop-down list, select the country in which the fax 
number resides.

9. In the Area/City Code field, enter the area/city code of the fax 
number.

10. In the Number field, enter the fax number.



114 6510 UM Client Application User Guide

Using the Web Client

11. Select the Set as Default checkbox if you want to make this e-mail 
address the default address and click OK.

12. Click Save.

13. To delete a fax number, highlight the number and click Remove.

14. To edit a fax number, highlight the number and click Edit.

Configuring a Fax Number Schedule

A Fax Number Schedule allows you to define when the system should send fax 
messages to certain fax extensions.

 To configure a fax number schedule:

1. Click User Settings. The User Settings (General) screen appears.

2. Click Fax. The Fax screen appears.

3. Click Schedule. The Fax Schedule dialog appears.

4. Select the Schedule Enabled checkbox to enable the schedule. 

5. In the From Year/Month/Day drop-down lists, select the year, 
month and day you want the schedule to begin.

6. In the To Year/Month/Day drop-down lists, select the year, month 
and day you want the schedule to end.

7. Click the checkbox that represents the day or days you want the 
schedule to be enabled, or select the Every day checkbox to enable 
the schedule every day.

8. In the Fax drop-down list, select the fax extension that is to be 
associated with the schedule. 

9. Click OK.
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VPIM Addresses 

The VPIM Addresses feature displays the user’s VPIM address. This address can only 
be changed by the administrator in the NBX UM Administration console.

 To view VPIM addresses:

1. Click User Settings. The User Settings (General) screen appears.

2. Click VPIM. The VPIM screen appears, and displays all existing 
VPIM addresses.
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WAP Addresses

Specifying a Wireless Application Protocol device address lets you define a WAP 
location to contact for message notification.

 To specify WAP addresses:

1. Click User Settings. The User Settings (General) screen appears.

2. Click WAP. The WAP addresses screen appears.

3. In the Country drop-down list, select the country in which the 
WAP address is located.

4. In the Area/City Code field, enter the area/city code of the WAP 
address.

5. In the Number field, enter the WAP number.

6. Click Save.
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Other Addresses

Specifying a SMS address lets you define a SMS location to contact for message 
notification.

 To specify other addresses:

1. Click User Settings. The User Settings (General) screen appears.

2. Click Other. The Other screen appears.

3. In the SMS field, enter the SMS address to send to.

4. In the Reply To field, enter an address that will appear in the 
message that the receiver will be instructed to reply to.

5. Click Save.
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Maintaining a Distribution List

Creating a distribution list provides you with an easy way to send messages to a 
group of people. For example, if you frequently send voice mail to the sales team, 
you can create a distribution list called “Sales Team” containing the names of 
everyone in the sales team. 

You can use a distribution list to when creating either an e-mail or voice mail 
message.

Note:  This option allows you to create and maintain up to 99 
distribution lists.  

Using the Toolbar Buttons

There are six buttons that allow you to perform various tasks within the Distribution 
List application.

Button Name Function

Create Distribution List Creates a distribution list

Delete Distribution List Deletes a distribution list

Save Distribution List Saves the distribution list

Refresh Distribution List Refreshes the distribution list if you 
make changes to it and do not click 
Save.

Add to list Adds name/address to the list

Remove from list Removes name/address from the list
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Creating a Private Distribution List

You can create a private distribution list that includes a number of inboxes and e-
mail addresses. When unread messages are received, the system will utilize the list 
and send the unread messages to the contacts on the private distribution list.

Note:  Public distribution lists are created by the System 
Administrator.

 To create a distribution list:

1. Click Distribution List. The Distribution List screen appears. 

2. Click Create Distribution List.

3. In the List Number field, enter the list number that you will 
reference from a phone. 

Note:  For more information on accessing a distribution list from 
your phone, refer to the Telephone User Guide.

4. In the List Name field, enter a descriptive name for the distribution 
list.
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5. In the Mailboxes field, enter the mailbox that you want to add to 
the distribution list. 

Note:  You can also highlight a mailbox, then click the Add to list 
arrow.

           To remove a mailbox, highlight it, then click the Remove from 
list arrow.

6. The Remote Sites field displays all other networked locations via 
AMIS or VPIM. Highlight a user, then click the Add arrow. The 
Remote Sites dialog appears.

7. Enter the remote site address and click OK.

8. In the Email field, enter the e-mail address that you want to add to 
the distribution list, then click Save Distribution List. 

Editing a Distribution List

After a distribution list is created, its properties can be edited.

 To edit a distribution list:

1. Click the scroll buttons until you find the distribution list that you 
want to edit.

2. Make the necessary changes and click Save Distribution List.

Deleting a Distribution List

A distribution list can be deleted.

 To delete a distribution list:

1. Click the Client scroll button to select a distribution list, then click 
Delete Distribution List. A message appears, prompting you to 
confirm deletion.

2. Click OK.

Maintaining Notifications

When you are away from your desk or out of the office, you often do not have any 
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way of knowing if you have received an e-mail or voice message. Web Client has 
the ability to notify you if you have received e-mail or voice message. For example, if 
you have received a voice mail message, you can instruct Web Client to notify you 
by an e-mail message or call to your cell phone, home phone, or another e-mail 
account.

Using the Toolbar Buttons

There are six buttons that allow you to perform various tasks within the Notification 
application.

Creating a Notification Rule

Notification rules determine how Web Client will notify you when you receive an e-
mail, voice mail, or fax. For example, if you want to be notified each time you 
receive a voice mail message, you can instruct the system to send you an e-mail. If 
you are using a cell phone, you can instruct the system to also contact you on the 
cell phone.

Note:  You cannot have more than one notification rule running at a 
time.

Button Name Function

Save Save the notification.

Refresh Refresh the display.

Schedule Display Notification Schedule dialog.

Add Item Add a notification schedule.

Delete Item Delete a notification schedule.

Delete All Delete all notification schedules.



122 6510 UM Client Application User Guide

Using the Web Client

 To create a notification rule:

1. Click Notification. The Notification screen appears.

2. From the Notifying Mode drop-down list, select the mode to 
search the numbers for notifications.
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3. In the Account Code field, enter your long distance access code if it 
is required to make a long distance call from your office.

4. In the Notification Rules box, Select the media type you want to 
set rules up for.

5. In the Voice Mail Rules box, select one or more voice mail rules. 
These rules determine when Web Client will notify you when you 
have received a message.

Note:  There are no rules for fax.

6. Click Save.

Mode Function

Restart from First After going through all the numbers associated to a current 
schedule once, Web Client begins from the first number again if it 
has not notified you during a full cycle.

Restart after Last Once going through a full cycle of the numbers with no successful 
notification, Web Client begins from the last address dialed and 
works its way backwards up the list.

Media Type Function

All Notify on all messages.

Note: This is the default setting.

Certified Notify only on messages marked certified.

Internal Notify only on internal messages.

Urgent Notify only on urgent messages.

Private Notify only on private messages.

External Notify only on external messages.

With Caller ID Notify only on messages with caller ID.
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Creating a Notification Address

Web Client allows you to specify phone and e-mail addresses that will be used to 
contact you when you have a message. After you have specified the contact 
methods, you can assign a schedule to a particular notification address. 

Note:  If the Phone, Beeper, or E-mail option buttons are not active, 
contact your System Administrator.

          There is no limit to the number of notification addresses that 
you can add.

Creating a Phone Notification Address

Web Client will contact you via the phone numbers that you specify each time you 
receive a voice message, e-mail, or fax.

 To create a phone notification address:

1. In the Notification Addresses box, click Add. The Address dialog 
appears.

2. Select Phone.
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3. From the Country drop down list, select a country

4. In the Area/City Code field, enter the phone number’s area code or 
city code.

5. In the Number field, enter the phone number.

6. In the Call It field, enter the number of times that Web Client is to 
call the phone number.

7. In the Busy field, enter the number of minutes that WebClient is to 
wait before retrying the number if it is busy.

8. In the No Answer field, enter the number of minutes that Web 
Client is to wait before retrying the number when there is a no 
answer.

9. Click OK. The phone number appears in the Notification Addresses 
field.

Creating a Beeper Notification Address

Web Client will contact you at the beeper numbers you create each time that you 
receive a voice message, e-mail, or fax.

 To create a beeper notification address:

1. In the Notification Addresses box, click Add. The Phone dialog 
appears.

2. Click Beeper. The Beeper dialog appears.
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3. From the Country drop down list, select a country.

4. In the Area/City Code field, enter phone number’s area code or 
city code.

5. In the Number field, enter the phone number

6. In the Call It field, enter the number of times that Web Client is to 
call the phone number. 

7. In the Between Calls field, enter the duration of time to wait 
before retrying the number again. (In minutes).

8. In the Wait field, enter the duration of time to wait before 
sending (in seconds).

9. In the Send field, enter the personal message that will appear 
when you receive a notification. This feature allows you to 
personalize your beeper notification, so that you will be aware of 
where the notification is originating. 

10. Click OK and then Save. The beeper number appears in the 
Notification Addresses field.
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Creating an E-mail Notification Address

Web Client will contact you at the e-mail addresses that you create each time that 
you receive a voice message, e-mail, or fax.

 To create an e-mail notification address:

1. In the Notification Addresses box, click Add. The Address dialog 
appears.

2. Click E-mail. The E-mail dialog appears.

3. In the E-mail field, enter the e-mail address, then click OK.

Removing a Notification Address

Individual notification addresses can be removed from a Notification List.

 To remove a notification address:

1. Highlight the address that you want to delete, then click Remove. 
A message appears, prompting you to confirm the deletion.

2. Click OK.
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Editing a Notification Address

The properties of individual notification addresses can be edited.

 To edit a notification address:

1. Highlight the notification address, then click Edit. Depending on 
the type of notification address you selected, the appropriate 
dialog appears.

2. Make the necessary changes, then click OK.

Creating a Notification Schedule

The Notification Schedule feature allows you to assign a schedule to a particular 
notification address. For example, you can create a schedule that instructs Web 
Client to call you on your cell phone Monday to Friday, between 9 am and 5 pm.

Note:  You must save all of your notification addresses before 
creating a notification schedule.

 To create a notification schedule:

1. Click Schedule. The Notification Schedule dialog appears.
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2. From the Default drop down list, select the notification address 
that Web Client will use to contact you if the schedule expires.

3. From the From - year, month, and day drop-down lists, select the 
year, month, and day that you want the schedule to begin.

4. From the To - year, month, and day drop-down lists, select the 
year, month, and day that you want the schedule to stop.

Note:  Select All Day if you want the schedule to run all day.

5. Enter the From and To hours, in military format. For example, if 
your company wants the notification to play from 9:00 AM to 5:00 
PM, set the hours as From 09:00 and To 17:00. If no time is entered, 
the system will assume all hours.

Note:  A value of From 13:00 to blank indicates 1:00 PM to midnight.

          The maximum value is 23:59 and the minimum value is 0:00.

          Other than a Blank value, the From field cannot be greater 
than the To field.

6. Select the days of the week that you want the schedule to run.

Note:  If you want the schedule to run every day, select Every day.
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Caution:   If two notification schedules are created and the days that they 
are designated to run overlap, the system will choose to use the 
default address. If the default address is not one of the 
addresses specified in the schedules, the system will randomly 
select an address.

7. From the Notification Addresses drop down list, select the 
notification addresses that will run.

8. Click OK.

Creating a Wakeup Call

You can use Web Client to act as an alarm clock to wake you up at a specified time.

Using the Toolbar Buttons

There are three buttons that allow you to perform various tasks within the Wakeup 
Call application.

Button Name Function

Clear Clears the fields of information.

Update Updates the wakeup call.

Refresh Refreshes the display.
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 To create a wakeup call:

1. Click Wakeup Call. The Wakeup Call screen appears.

2. From the Country drop down list, select a country.

3. In the Area/City Code field, enter either an area code or a city 
code.

4. In the Number field, enter the seven-digit phone number.

5. From the Date (month) drop down list, select the month. 

6. From the Date (day) drop down list, select the day. 

7. In the Time (hour) and Time (min) fields, enter the time when you 
want Web Client to issue the wakeup call, then click Update.
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Canceling a Wakeup Call

You can cancel a wake up if you do not want to woken at the specified time.

 To cancel a wakeup call:

1. Select a wakeup call.

2. Click Clear. A message appears, prompting you to confirm 
deletion.

3. Click OK. Web Client removes the wakeup call information from 
the display.
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Maintaining Greetings

Web Client comes equipped with 10 basic status messages that can be used to 
inform callers of your status (for example, if you are on vacation). You can also 
record up to 100 optional greetings. 

Note:  Before you can record a greeting, you must have the Grant 
Permissions and Java Plugin software installed on your PC. 
For more information, contact your System Administrator. 

          You must have a microphone attached to your PC to record a 
greeting.

Using the Toolbar Buttons

There are five buttons that allow you to perform various tasks within the Greetings 
application.

Button Name Function

Delete Deletes a greeting

Record Records a greeting.

Play Plays a greeting.

Refresh Refreshes the screen.

Play This icon appears beside a greeting if it a message has 
been recorded for it.
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Playing a Greeting

You can listen to your current or recorded greeting by using the Windows Sound 
Player.

 To play a status greeting:

1. Click the Play icon beside the greeting that you want to play. The 
Windows Sound Player becomes active and plays the message.

2. To play another greeting, close the Windows Sound Player, then 
repeat step 1. 



6510 UM Client Application User Guide 135

Using the Web Client

Recording a Greeting

Web Client allows you to create a greeting for each of the nine presence statuses.

Note:  The status greeting for the Name status is recorded when the 
System Administrator sets you up on the 6510 UM system. 
However, you can change the greeting.

 To create a status greeting:

1. Click Greetings. The Greetings screen appears.

2. From the Language drop down list, select the language that you 
want to record the message in.

Note:  The number of available languages depends on the 
languages that were specified when the 6510 UM was 
installed. For more information, contact your System 
Administrator.

3. Select the greeting that you want to record and click Record. The 
Windows Sound Recorder becomes active.
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4. In the Windows Sound Recorder, click Record and begin speaking. 
The record button changes to the pause button.

5. When you have recorded your message, click Stop.

6. Click Play to listen to your recorded message.

7. If you are satisfied with the message, click Save. Web Client places 
an Play icon beside the new greeting.

8. To play the greeting, select the radio button designated to the 
greeting type and click Play.
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Activating a Greeting

To activate a recorded greeting, select the greeting and it will be activated.

Deleting a Greeting

Web Client allows you to delete any greeting that you have recorded.

 To delete a greeting:

1. Select the greeting and click Delete. A message appears, 
prompting you to confirm deletion.

Note:  If you want to delete an Optional greeting, enter its number 
in the Optional field.

2. Click OK. Web Client removes the Play icon from the greeting.
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Collaborate

Collaboration is a facility that is provided to link you with your desired 
Collaboration/Meeting services. Once you define the collaboration service in the 
User Settings, simply click the Collaborate button, a new window will open and 
connect you to the defined Collaboration service.

Note: By default, WebEx is defined.
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CHAPTER 3 Using the Fax Client

In This Chapter...

Overview on page 140

Opening the Fax Client on page 140

Navigating the Administration Console on page 141

Using the Folders on page 142

Creating a Fax on page 144

Displaying and Modifying Fax Properties on page 153

Submitting a Fax to the Fax Server on page 156

Receiving and Viewing Faxes on page 162

Broadcasting a Fax on page 165
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Overview

Fax Client is a printer driver installed on your PC that allows you to send fax jobs to 
the Fax server over the IP. The application sits in the user tray, and allows you to 
print from any windows-based application (for example, Microsoft Word) to the Fax 
Server.

Each fax is stored in its own folder, depending upon whether it is an incoming 
(Inbox) or outgoing (Outbox/Sent Items) fax, or has been deleted (Deleted Items).

Each fax can contain one or more attachments.

Opening the Fax Client

1. Click Start > Programs > Fax > Fax Client. The Fax Client 
Administration Console appears. 

Exiting Fax Client

To exit Fax Client, close the window.
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Navigating the Administration Console

The Administration Console allows you to manage your entire mailbox, including 
creating a new fax, adding a cover page template, create, delete, rename or edit 
folders. You can also view faxes that have been sent or received, along with those 
faxes that are waiting to be sent.

Organization of the Administration Console

The Administration Console is made up of three windows: Folder Management, Fax 
Destination, and Document File. 

Using the Toolbar Buttons

There are eight buttons that allow you to perform various tasks within the 
Administration console.

Button Name Function

New fax Create a new fax

Add destinations Add a destination

Add files Add a file

View file View a file
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Using the Folders

Fax Client comes installed with four folders:

• Inbox—stores incoming faxes

• Outbox—stores all outgoing faxes

• Sent—stores all sent faxes

• Deleted—stores all deleted faxes

Creating a New Folder

In addition to the four folders that come with the software, you can create an 
unlimited number of new folders.

 To create a new folder:

1. Highlight the root folder from which the new folder will be 
created. 

Note:  You can create a new folder at the same level as the four 
original folders by highlighting Personal Folders.

2. Right mouse click on the folder, then select New Folder In (Folder 
Name).

3. Enter the name of the new folder and click OK.

Refresh Refresh the display

Delete Delete a fax

Send/Receive Send or Receive a fax

About Displays information about 
Fax Client
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Deleting a Folder

You can delete any existing folders, with the exception of the Inbox, Outbox, Sent 
Items, or Deleted Items folders.

 To delete a folder:

1. Highlight the folder.

2. Right-click and select Delete Folder. FaxClient moves the folder to 
the Deleted Items folder.
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Deleting a Folder Permanently

Once you have deleted a folder, you can remove it permanently from the Deleted 
Items folder.

 To delete the folder:

1. Highlight the folder that you want to delete.

2. Press the right mouse button, then select Delete Folder. A message 
appears, prompting you to confirm deletion.

3. Click OK.

Renaming a Folder

You can rename any existing folders, with the exception of the Inbox, Outbox, Sent 
Items, or Deleted Items folders.  

 To rename an existing folder:

1. Highlight the folder.

2. Right-click and select Properties.

3. Enter a new name and click OK.

Creating a Fax

There are two ways to create a fax: 

• From inside the windows-based application you are using to create 
the document (for example, Microsoft Word)

• From Fax Client. 

Either method allows you to create a fax with multiple destinations and 
attachments.
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Creating a Fax from the Print Dialog

If you are working on a document to fax using a windows-based application (for 
example, Microsoft Word), you can create the fax directly from the application. 

 To create a fax:

1. Click File>Print from the application. The Print dialog appears.

2. From the Name drop down list, select UM Fax Printer, then click 
OK. A message appears, confirming that the print job is in session.

After the file has been printed, the Fax Wizard dialog appears. For information on 
creating a fax, proceed to the next step, “Creating a Fax from the Administration 
Console”.
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Creating a Fax from the Administration Console

You can create a fax from the Administration console. 

 To create a fax:

1. Click New fax. The Select Fax dialog appears.

Note:  If you are creating a fax from the Print dialog, the Fax Wizard 
dialog appears.

2. In the Title field, enter the title for your fax document that will 
appear on the header document.

3. In the From field, enter the sender’s name.

4. In the Subject field, enter the subject of the fax.

5. From the Baud rate drop down list, select the speed that you want 
to send the fax at.

Note:  The Fax ID field displays a unique identifier for the fax. This 
information is used by software developers.

6. Click Next. The Select Destinations dialog appears.
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1. In the To field, enter the recipient’s name that will appear in the 
banner of the fax.

Note:  Click Address Book to display your Microsoft Exchange 
Contacts. Select a list of clients with fax numbers to send the 
document to, or enter a name manually. You can click on the 
address book and it will launch any MAPI based address book 
you have on your PC9 (for example, an Outlook contact list).

          To remove a client from the list or edit a client’s information, 
highlight the client, then click Remove. The client information 
reappears in the fields at the top, and you can either edit the 
information or change it.

2. From the Country drop down list, select the Country Code to use 
for International dialing purposes. Select the destination country 
from the list. The default is None.

3. In the Fax # field, enter the fax number dialing string required to 
reach the destination.
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4. Select Internal call if the destination is a fax client located on the 
same fax server.

5. Click Add to List, then Next. The Select Files dialog appears.

1. Select Attach additional files to the fax if you want to attach 
additional files. Click Add to List to navigate to the directory 
containing the files. The Add Fax Documents window appears.

Note:  You can choose files from any format, as FaxClient will 
convert them to TIFF format when they are sent. 

2. Highlight a file and click OK. Select Print document on the client 
side if you want the document to be printed to a TIFF file on the 
client side.

3. Click Scan & Add if your computer is connected to a scanner. 
FaxClient allows you to add the scanned image to the list of 
attachments.

4. Click Next. The Cover Page dialog appears.
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1. Select Yes if you want a cover page. Select the cover page from 
the list of templates.

2. From the Banner type drop down list, select one of the following 
banner types:

• US Standard

• None

• International Standard

3. Click Finish to process the fax or Next to specify more sending 
options. The Schedule dialog appears.
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1. Select a time to send to send the fax. The options are:

• As soon as possible—send the fax as soon as possible

• Specific time—specify a specific time to send the fax

If you select Specific time, enter the time that you want Fax Client to send the fax.

2. Select an Expiration time. The options are:

• Never expired—keep trying until successful

• Specific time—specify the time that the system is to stop trying to 
send the fax 

3. Select an Importance to define the priority on the server of when 
to send the fax. The options are:

• Normal

• Off peak hours (Defined on the server side)

• Urgent (Top priority)

4. Specify a retry mode. The options are:

• No retries—one attempt only
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• Standard—the system will try to send the fax up to four retries

• Extra retries—the system will try to send the fax up to seven retries

5. Click Finish to process the fax or Next to access more sending 
options. The Notification dialog appears.

1. Specify the reason to notify you of the status of the fax. The 
options are:

• Never—never notify you of the status or completion

• Failed Only (Default)—on failed attempts only

• Always—always notify me of no matter successful or failure

2. Specify the level of notification. The options are:

• Destination—for every fax

• Group—for every group completed

• Fax—for every destination or number sent to

3. Specify the detail of the notification message. The options are:
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• Quick—short message with the number and result

• Standard—offers time 

• High—offers complete detail on the task

4. Click Finish to process the fax or Next to access more sending 
options. The Finish dialog appears.

5. Select Defer job if you are offline and have no IP or Internet 
connection. You can defer the job and process it later when you 
are back online.

6. Select Transmit job to server if you are online and can transmit the 
job to the server. It is configured with your servers default settings 
and your user name and password for verification.

Note:  If you have multiple servers in different locations, you can 
enter the IP address of the server you want the job sent to. 
However, you must make sure that you have a valid account 
on that particular server to ensure receipt.

7. Click Finish.
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Displaying and Modifying Fax Properties

After you create a fax, you can make changes to the Cover Page, Schedule, 
Notification, and Server Journal before sending it to the Fax Server.

Note:  You can only change a fax that is still in the Outbox.

 To modify fax properties:

1. Highlight the fax and click Compose > Properties. The fax 
properties dialog appears.

2. To make changes to a particular setup screen, click the appropriate 
tab.

3. When you have completed all of the changes, click OK.
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Adding a Destination

If you have created a fax but have not sent it to the Fax Server, you can add one or 
more additional destination locations using one of several methods:

1. Highlight the fax, then click Compose > Add New Destination(s).

2. Right mouse click on the fax, then select Add New Destination(s).

3. Highlight the fax, then click Add destinations.

4. Highlight the fax, then press Ctrl+D.

Note:  The fax must still be in the Outbox to add any additional 
destinations.

Deleting an Existing Destination

Before you send the fax to the Fax Server, you can delete one or more of the 
destination locations using one of several methods:

1. Highlight the destination, press the right mouse button, then 
select Delete Destination.

2. Highlight the destination, then press Del.

3. Highlight the destination, then click Delete from the tool bar.

4. Highlight the destination, then click Compose > Delete.

Adding New Files

After you have created the fax, you can add additional files to it using one of several 
methods:

1. Highlight the fax, then click Compose > Add New File(s) from the 
main menu.

2. Highlight the fax. Right mouse click anywhere in the Document 
window, then select Add New File(s).

3. Highlight the fax. Highlight an existing attached file, then right 
mouse click and select Add New File(s).

4. Highlight the fax, then click Add files from the tool bar.

5. Highlight the fax, then press Ctrl+F.
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Note:  The fax must still be in the Outbox to add any additional 
files.

Deleting an Attached File

Before you send a fax to the Fax Server, you can delete one or more of the attached 
files using one of several methods:

1. Highlight the applicable file, right mouse click and select Delete 
File(s).

2. Highlight the applicable file, then click Delete on the tool bar.  

3. Highlight the applicable file, then click Compose > Delete.

Viewing Attached Files

You can view a file that you have attached to a fax using one of several methods:

1. Highlight the attachment, press the right mouse button and select 
View Original File.

1. Highlight the attachment, then select View file from the tool bar.

1. Highlight the attachment, then click View, then View File from the 
main menu.

Once the document has been converted to TIFF format, you can view the document 
by right mouse clicking on it, then selecting View Fax Image.

Deleting a Fax

You can delete a fax before sending it to the Fax Server using one of several 
methods:

1. Highlight the fax, then click Compose > Delete from the
main menu.

2. Highlight the fax, right mouse click and select Delete Fax from the 
menu.

3. Highlight the fax, then press Del.

4. Highlight the fax, then click Delete on the tool bar.
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Submitting a Fax to the Fax Server

After you have created the fax, you can either send the fax immediately or hold it 
until you have finished creating other faxes. 

 To submit a fax to the Fax Server:

1. Highlight the fax.

2. Click Deliver > Submit Fax (Fax Name) from the main menu.

Once the fax has been submitted, FaxClient moves it to the Sent Items folder, and 
changes the status of the attached file(s) to Converted (if the document was 
converted from a non-supported format).

Holding or Releasing a Fax

Faxes are held at the Fax Server if you applied a schedule when creating the fax. For 
more information, refer toCreating a Fax from the Administration Console on 
page 146. 

Specifying Delivery Options

You can customize the sending and receiving options for a fax, including sending 
and receiving faxes when you start Fax Client, and checking for new messages. 

 To change the delivery options:

1. Click Deliver > Options from the main menu. The Options dialog 
appears.
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2. Select Send and receive messages at startup if you want FaxClient 
to send faxes stored in the Fax Destination window. Selecting this 
option will also instruct FaxClient to receive all faxes addressed to 
you.

3. Select Check for new messages every 15 minutes if you want 
FaxClient to check for new faxes. The default is 15 minutes.

4. Select Show system message box on new fax message if you want 
FaxClient to notify you each time you receive a new fax.

5. Click OK.
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Changing a Cover Sheet

Fax Client comes with five pre-designed fax cover sheets (or templates). You can 
either use one of these existing cover sheets or add your company logo and contact 
information to an existing cover sheet.

 To change a cover sheet:

1. Click File > Register Cover Page from the main menu. The Register 
Cover Page dialog appears.

2. Select a file name, then click Edit. The Edit Cover Page dialog 
appears.
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• In the Full Path For Logo Picture field, enter the path to the directory 
containing the logo. 

Note:   Click Browse to search for the directory.

• In the Picture Size field, enter the width and height of the logo.

• In the Company Name field, enter the name of your company.

• In the Return Address field, enter the return address that you want to 
appear on the fax.

• In the Phone field, enter your company’s phone number.

• In the Fax field, enter your company’s fax number.

3. Click Preview to view the cover page. 

4. Click File>Close to return to the Edit Cover Page screen.

5. Click OK to return to the main menu.
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Printing Offline

If you sent fax jobs to the server while you were offline, you can send them once 
you are reconnected to the server.

 To print offline:

1. Click Start > Programs > Fax > Fax Client. The Fax Client screen 
appears. 

2.  Click Send/Receive. Fax Client connects to the default server and 
processes all jobs that were completed while offline.
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Checking the Status of a Fax Job

You can check the status of your fax in real time.

Note:  You must be online to check the status of a fax job. 

 To check the status of a fax job:

1. Click Start>Programs>Fax>FaxClient. The Fax Client Administration 
console appears.

2. Click on the file to view the fax.

3. Highlight the fax, then press the right mouse button to view 
advanced options.

4. Click Fax Properties for a live status of the fax job. The Fax 
Properties dialog appears.
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The properties dialog box summarizes all the options you selected while creating 
the fax job.

5. Click Server Journal for active status. 

6. Fax Client will notify you automatically if you select Notification.

7. Click OK to close the Fax Properties dialog.

Receiving and Viewing Faxes

To receive faxes that may be waiting for you, click Deliver>Send and Receive. 
FaxClient transfers the faxes from the spooler to the Inbox folder.

To view the contents of a fax, double-click on it. FaxClient opens the fax as a .tiff 
image. Once FaxClient displays the fax, you can open the image or print it.
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Forwarding a Fax 

Once you have received a fax, you can forward it to another destination.

 To forward a fax:

1. Highlight a fax in the Inbox folder. Press the right mouse button 
and select Forward Fax. The Forward dialog appears.

2. From the Local Users list, select a user to send the fax to, then click 
the right arrow. FaxClient pastes the user fame into the Recipient 
List field.

Note:  You can also click Address Book to display your Contact 
Manager.

3. Click Send.

Displaying Fax Properties

Each time that you highlight a fax in the Folder Management window, FaxClient 
displays information about that fax in the Fax Destination window. 
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Fax Destination window

The following table details each property and function in the Fax Destination 
window.

Displaying Attached Files

Each time that you highlight a fax in the Folder Management window, FaxClient 
displays information about the attached files in the Document File window.

Property Function

Attention Indicates the name of the person or organization that the fax is 
intended for.

Fax Number Indicates the fax telephone number that must be dialed to suc-
cessfully send the fax. Different dialing formats for different 
locations are accommodated in the Fax Wizard when faxes are 
created.

Send Time Indicates whether to send the fax immediately or at a specified 
time. To change the time, highlight the fax. then press the right 
mouse button. Select Destination Properties, then click the 
Schedule tab.

Pages Send Indicates the number of pages to fax.

Status Indicates the status of the fax. For more information, refer to 
Appendix A.
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Document File window

The following table details each property and function in the Document File 
window.

 Broadcasting a Fax

FaxClient allows you to send a fax to multiple locations at once using one of the 
following methods:

1. Select the clients from the Address Book. Enter each client’s 
information on the Select Destinations dialog, then click Add to 
List.

2. Select the clients from the Address Book, then add additional 
clients using the Select Destinations dialog.

3. Create a Distribution list in your Contact Manager, then select that 
list from the Fax Client.

Note:  At the present time, only Microsoft Outlook is supported.

Property Function

Document File Indicates the name of the file.

Format Indicates the format of the letter.

Flags Indicates the orientation and resolution of the attachment.

Print on Indicates if the attachment prints to a TIFF file on the server 
side or the client side.

Status Indicates the status of the fax. For more information, refer to 
Appendix A.
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Adding a Fax Cover Page

Fax Client version 1.2 supports pure HTML format, such as documents created using 
Microsoft FrontPage or Microsoft Publisher. 

Caution:  Mitel Networks recommends that you do not use Microsoft 
Word to convert your document to HTML, as Microsoft Word 
saves an HTML file in XML format that is not supported in this 
version of Fax Client.

 To add a cover page:

1. If you use one of the Fax cover page templates to make your cover 
page, click File>Register Cover Page from the main menu.

2. Select the template that you wish to use, then click Edit.

3. After you finish editing, save it in the same file name. If you save it 
as a new name, you must register the new template. For more 
information, refer to Changing a Cover Sheet on page 158.

4. If you prefer to not to use one of the templates, use Microsoft 
FrontPage to edit your new cover page. Save it in HTML format, 
then register the cover page with a new template name.

5. To remove a cover page from the list, highlight the template, then 
click Remove. 

6. To view an existing cover page, highlight the template, then click 
View.

Note:  The document cannot be edited.
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Flags
There are two flag sets: Destinations and Files.

Destination Flags
The following table displays the fax type and conditions for destinations.

File Flags
The following table displays the orientation and resolution of an attachment.

Flag Meaning
U Priority – Urgent

N Priority – Normal

L Priority – Low (send at peak time only)

S Scheduled for a certain time

C Sending with a cover page

X Has an expiration time

Flag Meaning
P Orientation – Portrait

L Orientation – Landscape

N Resolution – Normal

F Resolution – Fine
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Status
Each flag indicates the status of a fax.

Status Message Definition
Converted File converted to Faxable format

Failed to Receive Failed during fax receiving

Failed to Render Failed during file rendering phase

Failed to render cover page Failed to convert cover page to Faxable format

Failed to render cover template Failed to generate cover page from template

Failed to send Failed during sending of the fax

Need to render cover page Cover page not converted to faxable format

Need to render cover template Cover page not created from template

Ready Fax is finished. Destination is ready to send.

Rendering Destination has been received

Rendering cover page Rendering to faxable format is in progress

Rendering cover template Converting cover page to faxable format is in 
progress

Sending Sending is in progress

Sent Destination has been sent

Unprepared Fax is waiting to be prepared for faxing
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B
Before You Begin 8
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E
E-mail Settings Schedule 112
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Fax, creating 144
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Faxes
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Folders
Creating 142
Deleting 143
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Renaming 144

Folders, maintaining 83

G
Greetings, maintaining 133

I
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L
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M
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Message, composing 74

N
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Notifications, maintaining 120

P
Phone Addresses Schedule 107
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Using 66
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T
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Changing 158

U
UM Call Manager 24
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UM Client Manger, configuration 14
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V
Voice Message, playing 70

W
Web Client, starting 64
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